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Introduction
Wow! Awesome! Unbelievable! Fantastic! Cool! I didn’t know it had that! These are some of the comments I 
have been hearing from clients, students, and myself after I educate and demo the features below. As for me, a 
hard core IT Professional, I have been pleasantly surprised at the features of the Windows 7 operating system. 
If you have a Windows 7 machine as you read this article, you will become as excited as I have by trying these 
features first-hand. Without the live touch and feel, you may not fully understand these great features. It’s best 
if you are sitting at a Windows 7 computer when reading this so that you can interact with each feature. As the 
saying goes, “Try it. You’ll like it.” Not at a computer right now, read on for a great education!

It can be said that Windows 7 bears a striking similarity to Apple Mac’s OSx operating system. It builds on 
Windows Vista’s positives and eliminates many of that OS’s negatives. It adds new functionality, is less resource-
hungry than Vista, and it starts and shuts down noticeably faster. Whether or not you’re upgrading from Vista or 
moving up from Windows XP, you’ll need to know how to make the most of it in your environment. Here are tips 
and tricks that every IT Professional must know. Windows 7 is crammed with lesser-known, but still important, 
new and enhanced features that, taken together, deliver improved performance and productivity, better trouble-
shooting, stronger security, and a whole lot more. 

To say that Windows 7 is a polished version of Vista is a true statement, but it does not fully describe the rede-
sign, enhancement, and additional features Microsoft has put into their new operating system. From Windows 
3.1 to Windows Vista, the Windows operating system has taken many giant leaps. And while Vista received a 
lukewarm reception from some users, Windows 7 is likely to be remembered for addressing those criticisms; and 
much more. Microsoft seems to have paid attention to the feedback it received about Vista and created an OS 
that is not only stable, but also very capable.

In fact, there aren’t many changes to the overall look of Windows 7 when compared to Windows Vista. If you 
have some experience with Vista, you will feel comfortable with many similarities such as navigating around the 
desktop using Control Panel and Start Menu items. So to find out what is new in Windows 7, just read on and 
see for yourself. Check out my HotKey list at the end of this paper (#77).
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1. XP Mode
Do you remember Windows 95 and the restart into DOS mode? Windows 7 has a feature for those XP applica-
tions that do not work while running under Windows 7, and no reboot is necessary. It is an add-in to the operat-
ing system download Windows 7 XP Mode, known as XPM, free from the Microsoft. You will be able to run XP 
applications in an emulated XP virtualization environment. The download consists of a fully licensed version of 
Windows XP with SP3 Virtual PC environment from Microsoft. Your system will need to be running a CPU that 
supports processor-based virtualization and have installed Windows 7 Pro, Enterprise, or Ultimate edition. XP 
Mode only works with systems that have hardware virtualization (AMD-V or Intel VT) built-in and turned on. 
Unlike Virtual PC, though, it’s not a standalone virtualization program. Once installed, XP Mode works behind 
the scenes and allows programs to run seamlessly alongside native Windows 7 applications. Microsoft claims 
nearly 100% compatibility with current Windows XP applications in XPM. To help determine if your computer is 
capable of running this kind of environment you can download the Microsoft Hardware-Assisted Virtualization 
Detection Tool, known as HAV, to check if the computer processor supports Hardware Virtualization and if this 
setting is enabled in the Bios. Certain other hardware specifications might need to be in place; but no problem, 
the HAV will determine what is needed.

2. Windows 7 Compatibility Mode
Not to be confused with XPM above, you can 
try this built in “fix” if you have trouble run-
ning applications designed for the previous 
versions of Windows. Using the Compatibility 
Mode, you can configure an application to try 
to run in the version of Windows that it was 
written for. Check the option, and you will be 
able to select the versions of Windows to use 
to run the application.

To configure an application to run in Compat-
ibility Mode, right-click the application’s short-
cut, .exe, or installation program, and select 
Properties. Next, select the Compatibility 
tab, and you should see the option “Run this 
program in compatibility mode for.” 
(See the exhibit below). 

Note that if Compatibility Mode is not support-
ed for the application, the option will appear 
grayed out. The most likely reasons for this are 
that the application is designed for Windows 7 
only, or that it is a 64-bit application.
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3. Create and Mount VHD Files
Microsoft’s Virtual PC creates its 
virtual machine hard drives in VHD 
files, and Windows 7 can now mount 
these directly so you can access them 
in the host system. Click Start, type 
diskmgmt.msc, and press Enter; 
then click Action, Attach VHD, and 
choose the file you’d like to mount. It 
will then appear as a virtual drive in 
Explorer and can be accessed, copied, 
or written just like any other drive.

Click Action, Create VHD, and you 
can now create a new virtual drive of 
your own; right-click it, select Initialize 
Disk; and after it’s set up, right-click 
the unallocated space and select 
New Simple Volume. You will have 
a virtual drive that behaves just like 
any other, where you can drag and 
drop files, install programs, test parti-
tioning software, or do whatever you 
like. But it’s actually just this VHD file 
on your real hard drive that you can 
easily back up or share with others. 
Right-click the disk and select Detach VHD to remove it.

The command line DISKPART utility has also been upgraded with tools to detach a VHD file, and an EXPAND 
command to increase a virtual disk’s maximum size. Take a look at the new Windows 7 VHD options below.

DiskManagement Tool: With the ability to create  
and attach virtual hard drives from the GUI

Compatibility Properties: Selecting the  
Windows version to run the application  

in Compatibility Mode
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4. Jump to the JumpLists 
Jumplists are a feature of the re-designed taskbar that now becomes the quick-launch area throughout the en-
tire bar. Just drag your shortcut or application icon onto it. Jumplists give you the option to view a list of recently 
accessed files by application, even when the application isn’t open, by right-clicking on the application’s icon in 
the taskbar. It also allows you to quickly access a favorite playlist without opening your media player. Jumplists 
can also be found integrated into the Start Menu. The following exhibits show you the Jumplist for the Explorer 
icon and the Jumplist for the StartMenu. I have Word pinned to my Taskbar, and from a right-click of the icon, I 
select the recent document from Jumplist and Word opens with my document. It save mouse clicks.

TimeSaver: The JumpList for Windows Explorer 

Start Here: A JumpList integrated into the Start Menu
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5. Preview Running Apps
Hover over an icon button on the re-designed task bar, and you will get a preview view of an open window 
that pops up to show you what’s inside. You can move your mouse on top of the preview window to look at a 
full-size “peek,” which is a maximized temporary view of your opened window. Click on the window to keep 
it maximized. While in Peek View, you can close the peek window with the exit button on the top right of the 
window. You can also use the Win + T hotkey to scroll through the preview in the taskbar.

 
Preview Bar: A smaller preview, hover over for a full-sized ”peek” and an exit button to close Window

6. AeroPeek the Desktop
In case you have not noticed the Show Desktop Button has been moved to the far right side of the TaskBar, 
on the right side of the notification area. Put your mouse on this new button, and it will preview the desktop. 
Hold down the Windows Key + SpaceBar, and you can AeroPeek the desktop; release the hotkeys, and the 
windows return to their position previous positions.

7. Snap and Shake into Place
Known as AeroSnap, simply drag your window to the left or right edge of the desktop to snap and resize the 
window to one half of the screen. Drag the window to the top to maximize it. A pretty neat idea made neater by 
the use of the keyboard shortcuts Win + respective left/right arrow keys). No longer do you have to frus-
tratingly position the mouse at the edge of the window to resize it. Use the Aero Shake feature to minimize all 
background windows except your working window to the task bar, using your mouse. Grab the title bar of the 
window you wish to keep open and give it a shake. Have you ever had many, let’s say 10 or more, application 
and or tool windows open at the same time, and you wanted to minimize all of them except the window you 
were working on at the moment? Shake the window again and watch the background windows maximize. 

Wow!
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8. Switch Multiple Display Devices
Try Win + P. Do this even if you don’t have an external monitor or projector attached at the moment. You will 
still be able to see the “film strip” style of duplicating or extending your display to other monitors, it takes just a 
second to select. The Win + P or run DisplaySwitch.exe presents you with an Alt + Tab style menu, which is 
ideal if you give a lot of presentations on your laptop or want to rearrange your extended desktop.

9. A Stage for Your Device 
With the new Device and Printers button on the Start Menu, devices that are connected to your computer 
can have their own Stage. This Device Stage presents supported devices with a photo-realistic render and a link 
to the vendor’s website, along with other updates and useful information (such as firmware updates and manu-
als). Plug an external device into your machine and navigate to Device and Printers from the Start Menu. 
See what else your device tells you. Open an instance of the tool on your live machine and see what it will 
show. It will amaze you.

10. Eliminate the Notification Area
This choice is located in Control Panel under Notification Area Icons, or type Notification in the search line. What, 
I can even get rid of the clock and volume icons? Yes. Click the arrow that gives access to the overflow icons 
in the notification area and click customize. Select each icon and click hide icon and notifications to remove it. 
Clean up notifications by turning them all to off. With Windows 7, we finally see system tray icons behave in a 
similar way to everything else on the taskbar. So if you want to rearrange them, just drag and drop them into 
the order you like. You can decide to show icons of Running Programs and or which Notifications are displayed. 
The following is the view of which System icons to turn on or off.

Notification Settings: Configure notifications to off
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11. Problem Steps Recorder
Have you ever said to a user, “Can 
you show me the problem?” Yes, 
the Problem Steps Recorder 
lets you record a particular prob-
lem you are having with your PC 
so you can send it to someone 
who may be able to help. It’s also 
great for creating training tutori-
als. Type PSR in the search line 
and press Enter, then click Start 
Record, and a screenshot is taken 
with every mouse click, allowing 
comments to be added in between 
if required. These screenshots (and 
comments, if any) are placed in a 
well-formatted HTML document 
that is placed inside a zipped 
folder on your desktop and can be 
attached to an email. The follow-
ing are the PSR control panel and 
an example of a recording with 
comments.

 

12. Burn Images
Yes, Windows 7 finally introduces 
the ability to burn ISO images to 
CDs or DVDs. And it couldn’t be 
much easier to use. Just double-
click the ISO image, choose the 
drive with the blank disc, click 
Burn and watch as your disc is 
created. 

 

Problem Steps Recorder: Sample Recording

Windows Disk Image Burning: 
Burning an ISO file
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13. Troubleshooting Computer Problems
If some part of Windows 7 is not working, and you don’t know why, then click Control Panel under the Sys-
tem and Security category Find and Fix problems or type Troubleshooting in the search line to access 
the new troubleshooting packs. These are simple wizards that will resolve a long list of common problems, check 
your settings, clean up your system, and more, for both hardware and software issues. Also type in the search 
line Troubleshooting History and see what has taken place in the past. Click the View All link in the top 
left of the window, and you will see a long list of troubleshooting tools. You must try this!

14. Build a Startup Repair CD
I always ask my customers if they have a repair disk. But if you’ve downloaded Windows 7 for the internet it’s a 
good idea to create a system repair disc right away in case you run into problems booting the OS later on. Click 
Start > All Programs > Maintenance > Create a System Repair Disc, and let Windows 7 build a boot-
able emergency disc. If the worst does happen, then it could be the only way to get your PC running again. You 
will find Backup, Help and Support, and Remote Assistance there, too.

15. AppLocker to the Rescue
Frustrated with users who have rights for installing software or running applications they should not be run-
ning? AppLocker to the rescue. It’s a new Windows 7 feature that is similar in concept but easier to use that 
the old Software Restriction Policy. It ensures users can only run the programs you specify. It’s easier to set up 
than it sounds. You can create a rule to allow everything signed by a particular publisher. So let’s say you choose 
Microsoft as the publisher, this one rule will let you run all signed Microsoft applications. Launch GPEDIT.MSC 
and go to Computer Configuration > Windows Settings > Security Settings > Application Control 
Policies > AppLocker to get a feel for how this works.

16. Awesome Calculator
At first glance, the Windows 7 
calculator looks just like Vista’s 
version. Launch it by typing Calcu-
lator in the search line. Pull down 
the View menu and explore the 
context popup menu and you’ll see 
powerful new Statistics and Pro-
grammer views. Within the differ-
ent view there are unique Options 
menus for the mode the calculator 
is in at that moment. This offers 
many different unit conversions 
such as length, weight, volume, and 
more, date calculations (for ex-
ample how many days between two 
dates), and spreadsheet-type tem-
plates to help you calculate vehicle 
mileage, mortgage rates, and more. 

Calculator for Windows 7: The new Calculator is packed with useful  
features and functionality
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17. Get a Power Efficiency Report
If you have a laptop, you can use the efficiency calculator to get Windows 7 to generate loads of useful informa-
tion about its power consumption. This can help you make huge gains in terms of battery life and performance. 
Open a command prompt as an administrator by right-clicking it and choosing Run as administrator.

Then at the command line, just type in powercfg-energy and hit Enter, and Windows 7 will scan your system 
looking for ways to improve power efficiency. It will then publish the results in an HTML file in the System32 
folder. Use it to optimize your power.

18. System Restore Born Again
Windows 7 improves on the System Restore feature. Using System Restore in previous versions of Windows has 
been something of a gamble. There’s no way of telling which applications or drivers it might affect.

Windows 7 is different. Click the Start button, right-click Computer, and select Properties > System 
Protection > Configure, and set the Max Usage value to a size that suits your needs (larger to hold more 
restore points, smaller to save disk space). And if you don’t need System Restore to save Windows settings, then 
choose the Only restore previous versions of files option. Windows 7 won’t back up your Registry, which 
means you’ll squeeze more restore points and file backups into the available disk space. 

To restore, right-click Computer, select Properties > System Protection > System Restore > Next > and choose 
the restore point you’d like to use. Click the new button to Scan for affected programs, and Windows will tell 
you which (if any) programs and drivers will be deleted or recovered by selecting this restore point. Take a look!

19. New Time Zone Utility
System administrators will appreciate the new command line tzutil.exe utility, which lets you set a PC’s time 
zone from scripts. If you wanted to set a PC to Greenwich Mean Time, for instance, you’d use the command 
tzutil /s gmt standard tim. The command tzutil /g displays the current time zone, tzutil /l lists all possible 
time zones, and tzutil /? displays details on how the command works. 

20. Calibrate your Display
This tool is called Display Color Calibration. Since the colors you see on your screen will vary, depending on your 
monitor, graphics cards settings, lighting, and more, most people use the same default Windows color profile. 
And that means a digital photo you think looks perfect might appear very poor to everybody else. Windows 7 
now provides a Display Color Calibration Wizard that helps you properly set up your brightness, contrast, and 
color settings, and a Clear Type tuner to ensure text is crisp and sharp. Click Start, type DCCW in the search 
line, and press Enter. If you tend to hook up your computer to an HDTV or care about getting the highest qual-
ity from your monitor, then the in-built, basic, and easy-to-use calibration tools built into Windows 7 will please 
you. Give it a try.
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21. Clean up Live Essentials
Installing Windows Live Essentials will get you the new versions of Mail, Movie Maker, Photo Gallery, and others. 
Unfortunately, it also includes other components that may be unnecessary, but if you like to keep a clean system, 
then these can be quickly removed. For example if you left the default Set your search provider option se-
lected during installation, for instance, Windows Live will install Choice Guard, a tool to set your browser home 
page and search engine, and prevent other programs from changing them. If this causes problems later, or you 
just decide you don’t need it, then Choice Guard may be removed by clicking Start, typing msiexec /x, and 
pressing Enter. This is the Microsoft Windows Installer command line utility. To get the help file, type msiexec 
/? Windows Live Essentials also adds an ActiveX Control to help upload your files to Windows Live SkyDrive, 
a storage and sharing portal on the web, as well as the Windows Live Sign-in Assistant, which makes it easier 
to manage and switch between multiple Windows Live accounts. If you’re sure you’ll never need either, then 
remove them with the Control Panel Uninstall a Program applet under the Programs and Features link.

22. Magnifier Tool Re-Done
If you are, or someone you know is, visually impaired, then the Windows 7 Magnifier is just what the doctor 
ordered. The magnifier has three options for providing a bigger display. First type Magnifier in the search line to 
launch the console. Click the Views button in the console and there are three choices for your magnifier view 
with corresponding toggle keys. Full Screen: Ctrl + Alt + F, Lens: Ctrl + Alt + L, and Docked: Ctrl + Alt + D. 
There are Zoom In Zoom Out buttons, too. If you can’t find your way back to normal view, the magnifying 
glass, the kind that Sherlock Holmes uses, is positioned at the top left side of your desktop; click it to restore the 
magnifier console. Very functional!

 

Up Close: A sleek new magnifier that follows your cursor, without decreasing your workspace



Copyright ©2010 Global Knowledge Training LLC. All rights reserved.� 13

23. HomeGroup Networking 
In Vista and older operating systems, we had the concept of a Workgroup, and creating a shared folder over a 
network at home could be a bit of a pain. The procedure requires you to have a user account on the “shared 
folder” computer. In Windows 7, using the HomeGroup wizard, you simply right-click the default folders you 
would like to share, select Share With and choose HomeGroup Read or Read/Write. This will give you a 
passcode that you will need to enter in another computer on the same network to share the files. One caveat is 
that only Windows 7 computers can join a HomeGroup; but Windows 7 is backward compatible to join a Work-
group too.

24. Preview and Stream Your Music 
Opening and listening to an MP3 is a lot snappier with Windows 7 due to its new smaller preview player, pre-
senting you with album art, basic music functionality, and a link to the full-blown Windows Media Player. This is 
an obvious attempt to mimic the QuickTime Player preview feature of Mac OS X, and it is very well executed.  

Music Preview: The new preview is simple – and loads up very quickly

Windows Media Player allows you to stream music directly to other computers that are members of a Home-
Group. So, instead of listening to music through your tiny laptop speakers, you can wirelessly stream to the 
more powerful speakers of your PC in your living room, without stepping away from your laptop. The Windows 
7 Media Centre now comes with an option to play your favorite music, which by default creates a changing list 
of songs based on your ratings, how often you play them, and when they were added (it’s assumed you’ll prefer 
songs you’ve added in the last 30 days). If this doesn’t work, then you can tweak how Media Centre decides 
what a “favorite” tune is. Click Tasks, Settings, Music, Favorite Music, and configure the program to suit 
your needs. Windows Media Player 12 is a powerful program, but it still won’t play all the audio and video files 
you’ll find online. Fortunately, the first freeware Windows 7 codecs package has been released and is available 
at shark007.net/win7codecs.html. Installing it could get your troublesome multimedia files playing again.
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25. Action Center
The Windows 7 Action Center is the new Security Center for Windows 7, along with other notifications such as 
updates and access to the improved troubleshooting and recovery using restore point facilities. Basically, it is 
everything Windows usually annoys you with, rolled into one place with one icon in the notification bar. If you 
find the alerts irritating, you can tweak this feature to make it less annoying. I find it helpful as a reminder for 
routine maintenance like backups, virus scans, etc. Type Action in the search line to launch it.

26. Pin, Remove with the New Taskbar
With Windows XP, we had a Quick Launch area to drag shortcuts to. Now the entire taskbar is one gigantic 
Quick Launch, and then some. Drag just about anything on to it or right-click a shortcut, and on the context 
menu, you can select Pin to Taskbar, and the associated application will place itself on the translucent task-
bar, with an option to open the file in the Jumplist. If you prefer a more traditional approach, then right-click 
the taskbar, select Properties, and set Taskbar Buttons to Combine when taskbar is full. You’ll now get 
a clear and separate button for each running application, making them much easier to identify. One problem 
with this tip is the buttons will gobble up valuable taskbar real estate, but you can reduce the impact of this by 
removing their text captions. Launch REGEDIT, browse to HKEY_CURRENT_USER\Control Panel\Desktop\
WindowMetrics, add a string called MinWidth, set it to 54, and reboot to see the results.

27. Launch Your Previews
If you’re a hotkey guy like I am, you can use the Windows + icon position number to view or launch the pro-
grams from the icons on the taskbar. Let’s say Internet Explorer is the third icon counting to the right of the start 
button. Simply press the Windows + 3, and it will launch IE or let you view it if it is running. Try this one!

28. Right-Click Everything
At first glance, Windows 7 bears a striking resemblance to Vista, but there’s an easy way to begin spotting the 
differences; just right-click things. Right-click an empty part of the desktop, for instance, and you’ll find in the 
context popup menu an entry to set your screen resolution. No need to go browsing through the display settings 
any more. Right-click the Explorer icon on the taskbar for speedy access to common system folders: Docu-
ments, Pictures, the Windows Explorer folder, and recently opened folders. Your pinned folders are there too. 
And if you don’t plan on using Internet Explorer or any program on the taskbar, then you probably won’t want 
its icon permanently displayed on the taskbar. Right-click the icon, select Unpin this program from the 
taskbar.

29. Desktop Slideshow
Windows 7 comes with some very attractive new Wallpapers, and it’s not always easy to decide which one you 
like the best. So why not let choose a few, and let Windows display them all in a desktop slideshow? Right-click 
an empty part of the desktop, select Personalize > Desktop Background, then hold down Ctrl as you click 
on the images you like. You can even choose your own family pictures. Choose how often you’d like the images 
to be changed, anything from daily to once every 10 seconds; select Shuffle if you’d like the backgrounds to 
appear in a random order, then click Save Changes and enjoy the show.
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 Desktop Slideshow: Select multiple background images, and Windows will cycle through them

30. Customize the Log-on Screen
Yes, you can change that boring Windows logon screen to a background and picture of your choice. Windows 7 
makes it easy to edit the registry location for this. Type REGEDIT, and browse to: HKEY_LOCAL_MACHINE\
Software\Microsoft\Windows\CurrentVersion\Authentication\LogonUI\Background, double click 
the DWORD key called OEMBackground. If it’s not there create it and set its value to 1.

Now, find a background image you’d like to use. Make sure it’s less than 256KB in size and matches the aspect 
ratio of your screen, as it’ll be stretched to fit. Next, copy that image into: %windir%\system32\oobe\info\back-
grounds folder (create the info\backgrounds folders if they don’t exist). Rename the image to backgroundDe-
fault.jpg, reboot, and you should now have a custom log-on image. Viola! 

31. Restore the Old Quick Launch Toolbar
If you’re unhappy with the new taskbar, even after shrinking it, then it only takes a moment to restore the old 
Quick Launch Toolbar. Right-click the taskbar, choose Toolbars > New Toolbar, type: %UserProfile%\Ap-
pData\Roaming\Microsoft\Internet Explorer\Quick Launch into the Folder box and click Select Folder. 
Now right-click the taskbar, clear Lock the taskbar, and you should see the Quick Launch toolbar, probably to the 
right. Right-click its divider, clear Show Text and Show Title to minimize the space it takes up. Complete the 
job by right-clicking the bar and selecting View, then Small Icons for a genuine old-fashioned look.

32. Custom Power Switch
By default, Windows 7 displays a plain text Shut down button on the Start menu, but it only takes a moment 
to change this action to something else. If you reboot your PC a few times every day, then it might make more 
sense to set a reboot as the default action. Right-click the Start button, select Properties and set the Power 
boot action to Restart to make it happen.
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33. Auto Arrange Your Desktop
If your Windows 7 desktop has icons scattered everywhere, then you could right-click it and select View, Auto 
arrange, just as in Vista. But a simpler solution is just to press and hold down F5, and Windows will automati-
cally arrange its icons for you. Awesome!

34. Disable Smart Window Arrangement
Windows 7 features interesting new ways to intelligently arrange your windows, so that if you drag a window 
to the top of the screen, it will maximize. I like this feature, but if you find it distracting, then it’s easily disabled. 
Run REGEDIT, go to HKEY_CURRENT_USER\Control Panel\Desktop, set WindowArrangementActive to 0, 
reboot, and your windows will behave just as they always did. 

35. Browse Your Tasks
If you prefer the keyboard over the mouse, you will love browsing the taskbar using this nifty shortcut. Press and 
hold down the Windows key and click the letter T key. This will move the “focus” to the left-most icon on the 
taskbar. Then, while still holding down the Windows key, use your arrow keys or the Windows + T key to 
change the “focus” from left to right to other icons’ You will also get a live preview of every open window.

36. Boost with ReadyBoost
Want a simple way to speed up your PC? Just plug 
in a USB flash drive or card and let ReadyBoost 
borrow it. ReadyBoost is designed to help when 
your PC’s memory is running low. Low memory can 
make your computer sluggish because Windows, 
which needs a place to stash data, turns to the hard 
drive. Flash memory offers a speedier alternative. 
ReadyBoost works with most flash storage devices. 
In Windows 7, it can handle more flash memory 
and even multiple devices, up to eight, for a maxi-
mum 256 gigabytes (GB) of additional memory. 
ReadyBoost can be dynamically turned off at any 
time. Adjust the slider bar to adjust the amount 
of space you want to allocate for ReadyBoost and 
how much will be left over for storage space. On 
my laptop, I am using a SD card as a ReadyBoost 
device. Yes, it’s faster, thank you for asking.

  

ReadyBoost: Properties dialogue box
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37. Display Your Drives
Click Start then Computer, or Windows + E key, and you might notice something strange. Windows 7 does not 
show empty drives by default, but don’t panic, they’re still there. Drives and memory card readers are no longer 
displayed if they’re empty. I think it’s an improvement but, if you disagree, then it’s easy to get your empty 
drives back. Launch Explorer, click Tools > Folder Options > View, and clear Hide Empty Drives in the 
computer folder. And you thought something was broken.

38. Hiding the Windows Live Messenger Icon
If you use Windows Live Messenger a lot, you’ll have noticed that the icon now resides on the taskbar, where 
you can easily change status and quickly send an IM to someone. If you prefer to keep Windows Live Messen-
ger in the system tray, where it’s been for previous releases, just close Windows Live Messenger, edit the 
shortcut properties, and set the application to run in Windows Vista compatibility mode. I run IM this way on my 
machine.

39. Reduce the Icon Size
Simple, just right-click the Taskbar 
and select Properties, then select 
Small Icons check box on Taskbar 
Tab.

 

 
TaskBar Properties: It saves room by al-
lowing more of the desktop to display

40. UAC Re-Done
Windows Vista’s User Account Con-
trol was created to warn and even 
prevent installations and insertions 
into the registry without administra-
tor approval, but it turned out to be 
too restrictive, especially for legacy 
applications, and it raised far too 
many alerts. Fortunately Windows 7 
displays fewer warnings by default, 
and it lets you further fine-tune 
UAC to suit your preferred balance 
between always being notified, to 
“don’t notify for operating system 
changes to System settings,” to not 
being notified at all. Go to Start > 
Control Panel > Change User 
Account Control Settings.

Slider for UAC: You set the amount of control
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41. Sticky Notes Are Built-In
The Sticky Notes application is both simpler and more useful in Windows 7 than it was in Vista. Launch StikyNot.
exe, or you can type notes or sticky in the search line. When it launches, right-click a note to change its color. 
To add another note, click the + sign on the note title bar or CTRL + N. Click a note and press Alt + F4 to close 
the note window and, wow, your notes are automatically saved; relaunch and you will see your old notes.

42. Open Folder in New Process
By default, Windows 7 opens folders in the same process. This saves system resources, but means one folder 
crash can bring down the entire shell. If your system seems unstable, or you’re doing something in Explorer that 
regularly seems to causes crashes, you can open Computer from the StartMenu, hold down Shift, right-click 
on your drive, and select Open in New Process. The folder will now be launched in a separate process, so a 
crash is less likely to affect anything else.

43. Preview Fonts
Windows 7 has some useful font-related improvements. Go to Contol Panel icon view or type Fonts in the 
search line, and the new Fonts window will open. You’ll find a little preview for every font, giving you a quick 
idea of how they’re going to look. Scroll through multiple entries for each family, like Times New Roman, Times 
New Roman Bold, Times New Roman Bold Italic, and so on. And there’s a new OpenType font, Gabriola, added 
to the mix. There is a Restore Default button, if you need it. Try it. 

44. Restore Your Gadgets
Windows 7 has tightened up its security by refusing to run gadgets if UAC has been turned off, thereby limiting 
the damage malicious unsigned gadgets can do to your system. If you’ve disabled UAC, and want your gadgets, 
and are happy to accept the security risk, there’s an easy Registry way to get everything back to normal. Run 
REGEDIT, go to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Sidebar\
Settings, create a new DWORD value called AllowElevatedProcess, and set it to 1. Your gadgets should 
start working again right away. Gadgets can be selected by right clicking on the Desktop and in the context 
popup menu click Gadgets. Pick your Gadgets.

45. New WordPad Formats
You probably haven’t given much thought to WordPad lately, but the version shipping with Windows 7 has 
undergone a major renovation. Think of it as a lite version of Microsoft Word. WordPad sports a spiffy ribbon in-
terface, making it a snap to create well-formatted documents. Plus, you are no longer relegated to saving them 
as .RTF files. WordPad now supports the Office Open XML document (.DOCX) format. This makes it even easier 
to open .DOCX files created in Word in WordPad. By default, WordPad will save documents in Rich Text Format, 
just as before. But browse the Save as Format list, and you’ll see you can save files in the Office 2007 .docx 
or OpenDocument .odt formats. Fantastic!
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46. Protect Your Data 
Known as “BitLocker to go,” this will protect USB flash drives that are convenient, portable, and very easy to 
lose. This is a problem, especially if they’re carrying sensitive data. Fortunately, Windows 7 has the solution: 
encrypt your documents with an extension of Microsoft’s BitLocker technology, and only someone with the 
password will be able to access it. Right-click your USB flash drive, select Turn on BitLocker and follow the 
instructions to protect your private files. You will need the Ultimate version to enable this feature. BitLocker is 
totally portable and does not need Windows 7 to unlock the device. Plug it into any computer and double-click 
the Bitlocker.exe file to launch the Unlock Dialogue Box. 

Protect your Data: USB flash drives can easily be encrypted with BitLocker

47. Run As Is Back
Hold down Shift, right-click any program shortcut, and you’ll see an option to run the program as a different 
user, which is handy if you’re logged in to the kids’ limited account and need to run something with higher privi-
leges. This isn’t really a new feature - Windows XP had a Run As option that did the same thing - but Microsoft 
stripped it out of Vista, so it’s good to see they’ve had a change of heart.

48. Search in Privacy and InPrivate
By default, Windows 7 will remember your PC search queries, and display the most recent examples when 
searching in Windows Explorer. If you’re sharing a PC and don’t want everyone to see your searches, then 
launch GPEDIT.MSC, go to User Configuration > Administrative Templates > Windows Components 
> Windows Explorer > double-click Turn off display of recent search entries..., > click Enabled, 
then OK. You can now search the Web using the search functionality. Windows 7 includes Federated Search to 
increase the search scope beyond the local and network resources. Several search connectors are available, such 
as for YouTube and Twitter, or you can create custom ones to fit your needs.



Copyright ©2010 Global Knowledge Training LLC. All rights reserved.� 20

49. Tweak PC Volume
By default, Windows 7 will now automatically reduce the volume of your PC’s sounds whenever it detects 
you’re making or receiving PC-based phone calls. If this proves annoying (or maybe you’d like it to turn off other 
sounds altogether), then you can easily change the settings accordingly. Just right-click the Speaker icon in 
your taskbar, select Sounds > Communications, and tell Windows what you’d like it to do.

50. Extend Your Battery Life
Windows 7 includes new power options that will help to improve your notebook’s battery life. To see them, click 
Start, type Power Options, and click the Power Options link, then click Change Plan Settings for your 
current plan, and select Change Advanced Settings. Expand Multimedia Settings, for instance, and you’ll 
see a new “playing video” setting that can be set to optimize power savings rather than performance. Browse 
through the other settings and ensure they’re set up to suit your needs.

51. Write Crash Dump Files
Windows 7 won’t create memory.dmp crash files if you have less than 25GB of free hard drive space. This is 
annoying if you’ve installed the Windows debugging tools and want to diagnose your crashes. You can turn this 
feature off, though: browse to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Crash-
Control, create a new DWORD value called AlwaysKeepMemoryDump, set it to 1, and the crash dump file 
will now always be saved.

Shift to and from

Explorer and

CommandPrompt

Embrace

Troubleshooting

Packs

Configure User Account
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60 Get More Windows
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52. Go 64-Bit
As the second major Windows release to fully support 64-bit, the x64 architecture has definitely arrived on the 
desktop. Even subnotebook Laptops are built on x64 hardware; I have one myself. I am using 64-bit Windows 7 
Ultimate on an 11 inch x64 laptop as I type this white paper. Most business users do not need the more expen-
sive Ultimate Edition; stick with Professional, unless you specifically need BitLocker.

53. Windows PowerShell v2
More than just a shell, this is the administration tool you’ve always wanted: Parallel, distributed processing 
for administrative tasks! Manage 100 machines, literally, as easily as you manage one with the new Remoting 
feature. Windows PowerShell v2 ships for the first time in Windows 7 and will be available for older versions 
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of Windows. If you want to make the most of Windows PowerShell on Windows 7, you’ll need a quick way to 
build and debug scripts. Windows 7 comes with an interactive editor that allows you to try out cmdlets and test 
functions on the fly. Many will prefer to use the graphical Windows PowerShell console, also known as the Inte-
grated Scripting Environment (ISE). You’ll find this in the Windows Power¬Shell folder under Accessories. Add a 
keyboard shortcut of Ctrl+Alt+I to quickly launch it. Run any Windows PowerShell command in the lower panel 
and see the results in the middle. Create or edit scripts in the top pane. Open multiple Windows PowerShell ses-
sions connected to remote computers. The ISE makes Windows PowerShell v2 easy to use and fun.

Windows Power Shell: the Integrated Scripting Environment (ISE).

54. Shift to and from Explorer and Command Prompt
The classic Windows Power Toy “Open Command Prompt Here” is now an integral part of Windows 7 Explorer. 
Hold down the shift key then right-click a folder to add this option to the property menu. While you’re in a com-
mand prompt, if you want to open an Explorer window with the focus of the window on the current directory, 
type explorer and press Enter.

55. Employ Deployment Image Servicing and Management (DISM)
If you quickly want to list or manage Windows packages, features, or drivers, use the command-line utility 
DISM. The “image” in the name may fool you into thinking that this is solely a deployment tool. An online 
command-line switch lets you manage the features in the currently loaded OS. To get a list of the loaded Win-
dows features, open an Admistrator Command Prompt (right-click the command prompt Icon and select run as 
administrator) enter dism /online /get-features /format:table. To enable a feature, enter dism /online 
/enable-feature /featurename:<name>.; or just type DISM to see help for a list of commands.
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56. Check Reliability
The Reliability Monitor was introduced in Windows Vista as “The Reliability and Performance Monitor.” In Win-
dows 7, it has been separated from Performance Monitor and moved to a new location under the Action Center. 
To launch the Reliability Monitor, open the Action Center in Control Panel, then look under the Maintenance 
options for the View reliability history link. You can also just type in Reliability Monitor from the search 
line. Three categories of history are shown: Information-Blue Icon, Warnings-Yellow Yield Icon, and Critical 
Events - Red Icon. You can click the link at the bottom of the tool to view all problems and check for solutions. 

 
The Reliability Monitor: Show history and time line

57. Snipping Tool
 The snipping tool has also been around in various incarnations, but it’s even easier to use in Windows 7. Launch 
the tool, then drag and drop any part of your screen. The tool will snip the selection. You can save it as a graphic 
file or annotate with basic drawing tools. Teach your end-users how to use this tool so they can grab the snap-
shots of their problems and send them to the help desk. Or you can create your own library of visual notes.

58. Reduce the Clutter
Press Windows + Home to minimize all but the current window, removing background clutter and leaving you 
with the window that you are working with. See for yourself!

59. New Mouse-Click for Administrator
Windows 7 makes it easy to gain admin rights with a keyboard shortcut. Click on Ctrl + Shift on a taskbar-
locked icon, and you’ve launched it with appropriate admin rights. No need for a right mouse click.

60. Faster Installations 
If your computer is capable of booting from USB, try this: XCopy the Windows 7 installation DVD to a sufficiently 
large USB drive, boot from that drive, and install Windows from there. It’s faster than spinning the CD platter.
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61. Additional Clocks
If you work with offices in different time zones and frequently find yourself missing meeting times because 
you are not in sync with their time zone, try the Additional Clocks feature that was first introduced in Vista. 
Within your Date and Time settings is a tab called Additional Clocks, where you can add two or more clocks to 
your taskbar time, and set them to provide different time zones from your current time zone.

62. Associate Your Files
The file association we are so accustomed to using has been moved to a newly created area called Program 
Defaults that is now located off of the Start Menu. You can use this to set associations for file extensions of all 
sorts and what programs they will launch. The change AutoPlay settings are also in this area, from inserting a 
DVD to inserting a Camera or a PDA device. Program Defaults are also set from this location.

63. RoboCopy
The always-useful Robocopy.exe can now run multi-threaded; run RoboCopy /? to review its new parameters 
(like /MT for multithreading) and make your copies go faster.

64. Remote Desktop Tools
Type remote in the search line, and you will see Remote Desktop Connection, Remote Desktop Services manag-
er, Remote Desktops, and Windows Remote Assistance. All these apps will be discussed in another white paper 
dealing with Windows 7 remote ability. In the meantime, launch them and become familiar with their uses.

65. Add Shared Folders to Library
You can add UNC paths such as \\servername\sharename to a Library, but the server must index the folder. To 
add a UNC path to an unindexed server, create a symbolic link to the UNC path, then add the link or links to the 
library. Use the mklink command. For example, mklink HomeFolder \\ServerName\Homefolder. 

66. Manage Passwords
Control Panel includes a new application 
called Credential Manager. Type Creden-
tial from the search line to launch. This 
is a completely new tool that allows you 
to save your credentials (usernames and 
passwords) for Web sites you log into and 
other resources you connect to, such as a 
HomeGroup network. Those credentials 
are saved in the Windows Vault, which 
can be backed up and restored. You can 
also manage passwords for your account 
as well as user accounts from a Home-
Group networking setup. You can Backup 
and Restore the Windows Vault and link 
your stored ID to an on-line account. Credential Manager: a handy, secure place to store passwords
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67. Trigger and Event
Event Viewer is closely tied into Task Scheduler. You have the ability to take an event (select it in Event View-
er) and then from the Actions pane or a right mouse click, select the option Attach a Task to have that event 
perform one of three kinds of Tasks: Start a Program, Send an Email, or Display a Message. When the event 
appears, it will trigger the task you set. This feature may be very helpful in troubleshooting a problem. When the 
need arises, reconfigure or disable the task in the Task Scheduler tool.

68. Windows Live
Many applications installed on past versions of Windows have been removed. Starting with Windows 7, these 
applications (and a few others not typically installed with Windows) have been moved into the Live Essentials 
downloadable applications, at download.live.com. These applications include Messenger, Mail, Writer, Photo 
Gallery, Movie Maker, Family Safety, and a few others. You can download Microsoft’s antivirus protection, called 
Microsoft Security Essentials. It’s running on my system as I write this and, it gets the job done. I haven’t had a 
problem since.

69. Uninstall Apps and IE8 
Although some applications have 
been moved off of Windows to 
become optional downloads, other 
apps, such as IE8, Media Player, Me-
dia Center, and DVD Maker, are still 
included. In times past, especially 
when it came to IE, the applications 
were tied into the OS. However, in 
Windows 7, you can easily re-
move them if desired. Head to the 
Program and Features applet in 
Control Panel and select the Turn 
Windows features on or off 
link in the top left-hand corner. Then 
you can select the checkbox of the 
features you want to remove or add 
for your system.

 
Windows 7 Features On-Off: making 

it easy to add and remove them
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70. Windows 7 Experienced Rating
System properties have a rating called the Windows Experience Index (WEI). This rating is a collection of five dif-
ferent ratings that are determined by the Windows System Assessment Tool (WinSAT). The highest rating score is 
7.9 (compared to 5.9 in Vista), using the categories of Processor, RAM, Graphics, Gaming Graphics, and Primary 
Hard Disk. The final rating is not an average of all the ratings, but the lowest of the subcomponent scores. 

71. Analyze Processes
One of the coolest new features in 
the revamped Resource Monitor 
(resmon.exe) is the ability to see the 
“wait chain traversal.” An unrespon-
sive process will be shown in red 
in the Resource Monitor; right-click 
the process and choose Analyze 
Process. This will show the threads 
in the process and see who holds 
the resources that are holding up the 
process itself. You can then kill that 
part of the process if you like. Click 
the button bars under each category, 
and you will see what the system is 
busy with. The columns can be sorted 
by clicking the top of the column. 
Type Resource or Resmon in the 
search line, or you can launch it from 
Task Manager/Performance Tab/
Resource Monitor Button.

				     The new Resource Monitor: it shows you what your system is busy with.

72. Surf InPrivate
IE8 on Windows 7 offers more security and tight integration with the operating system than IE8 running on 
XP. One example of this is the Enable Protected Mode security setting. It is enabled from the Internet Op-
tions/Security tab and prevents unauthorized internet installations. A new feature in IE8 is the ability to open 
the browser in an InPrivate Browsing session that allows you to perform banking and so forth from a public 
location without fear of leaving behind any tracks. IE will not retain anything you do in an InPrivate Brows-
ing session. You can perform this action if you are already within IE by selecting the Safety button and then 
InPrivate Browsing. Or from with a browsing session, hold down Ctrl + Shift + P This will open another IE 
window. InPrivate can be launched from the JumpList with a simple right-click on the  icon on the Taskbar and 
clicking Start InPrivate Browsing. You can save a few steps by using the shortcut. Right-click the desktop IE 
icon, click InPrivate, and the windows will open in an InPrivate session. If you want a more permanent solu-
tion, edit the properties of the shortcut  icon by add the private switch at the end of the target location path.
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73. Enhanced Task Manager
The Windows 7 Task Manager now includes a tab to manage services. You can quickly see the status of all ser-
vices on your machine. Click a column heading to sort. You can even start and stop services with a simple right-
click. If you need full-blown service management, use the Services button to launch the services management 
console. You may often have the Task Manager running in the system tray; now, having service management ac-
cess means one less open window. Launch Resource Monitor from within the performance tab of Task Manager.

74. Your System Health
Another new system tool you’ll enjoy is the System Health report. In the search line, type perfmon /report, 
which generates a system health report. This report records details about your computer’s performance, resource 
usage, and more. The report also includes diagnostic information about things that aren’t working as they 
should and suggests steps to resolve them. The reports are saved and can be accessed with the Performance 
Monitor management console. You can also save as an HTML file or send via e-mail. Nice feature!

75. Install It on the Old Computer
One perhaps-not-so-obvious Windows 7 tip is that you should attempt to install it everywhere. One user has a 
6-year-old laptop that originally shipped with Windows XP. He could never get Windows Vista to install on it, 
but Windows 7 installed without a complaint and runs extremely smoothly. Granted, there are some Windows 
7 features he can’t take advantage of because the processor lacks certain features, but these are minor issues 
considering the laptop now has life again. So dust of those old computers.

76. Redesigned Help and Support
Help and Support has a redesigned for simplicity. The main page has three features: a Search Box, a link back 
to Microsoft’s WindowsWeb site, and a Button labeled Ask. You can click the Ask button at the top right of the 
window, or the More Support Options button in the bottom left of the Home Page. Click it, and this is where 
Microsoft is hiding the Ask a Person for Help. You will find Remote Assistance, Microsoft Help Forums, and 
Computer Manufactures Homepage. It’s much less intimidating for end-users, so make sure they know about it. 
Search is much improved as well, making for better, faster searches.

77. 17 Useful Windows 7 Keyboard Shortcuts
Win+h – Move current window to full screen 

Win+i – Restore current full-screen window to normal 
size or minimize current window, if not full-screen

Win+Shift+arrow – Move current window to alternate 
screen

Win+D – Minimize all windows and show the desktop

Win+E – Launch Explorer with Computer as the focus

Win+F – Launch a search window

Win+G – Cycle through gadgets

Win+L – Lock the desktop

Win+M – Minimize the current window

Win+R – Open the Run window

Win+T – Cycle through task bar opening Aero Peek for 
each running item

Win+U – Open the Ease of Use center

Win+Space – Aero Peek the desktop

Win+Tab – Flip 3D

Win+Pause – Launch System applet 

Alt+F4 – with windows closed launches the Shut 
Down Windows dialog box.

Alt+Tab – Film Strip
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Summary 
I have listed 77 Windows 7 features, some in the form of quick tips and tricks and some in the form of detailed 
explanations. Use this white paper as a reference to the enormous enhancements built into Windows 7. There 
are other built-in features that I will expand on in future white papers that will include such features as Win-
dows Event Collection Utility and Subscriptions, Direct Access and VPNs, plus others. Do you know of other 
features that I am not including at this time? If you find any features worth mentioning or have any comments 
send me an e-mail to: markmiz@comcast.net; I’d love to hear from you.

Learn More
Learn more about how you can improve productivity, enhance efficiency, and sharpen your competitive edge. 
Check out the following Global Knowledge course(s):

Implementing and Administering Windows 7 in the Enterprise (M50292) 

Planning and Managing Windows 7 Desktop Deployments and Environments (M6294)

For more information or to register, visit www.globalknowledge.com or call 1-800-COURSES to speak with a 
sales representative.

Our courses and enhanced, hands-on labs and exercises offer practical skills and tips that you can immediately 
put to use. Our expert instructors draw upon their experiences to help you understand key concepts and how to 
apply them to your specific work situation. Choose from our more than 1,200 courses, delivered through Class-
rooms, e-Learning, and On-site sessions, to meet your IT and business training needs. 
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